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1 Introduction

Sledgehammer is a tool that applies automatic theorem provers (ATPs) and
satisfiability-modulo-theories (SMT) solvers on the current goal.1 The sup-
ported ATPs are agsyHOL [12], Alt-Ergo [3], E [14], E-SInE [9], E-ToFoF
[16], iProver [10], iProver-Eq [11], LEO-II [2], Satallax [6], SNARK [15],
SPASS [18], Vampire [13], and Waldmeister [8]. The ATPs are run either
locally or remotely via the SystemOnTPTP web service [17]. In addition to
the ATPs, a selection of the SMT solvers CVC3 [1], Yices [7], and Z3 [19]

1The distinction between ATPs and SMT solvers is convenient but mostly historical.
The two communities are converging, with more and more ATPs supporting typical SMT
features such as arithmetic and sorts, and a few SMT solvers parsing ATP syntaxes.
There is also a strong technological connection between instantiation-based ATPs (such
as iProver and iProver-Eq) and SMT solvers.
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are run by default; these are run either locally or (for CVC3 and Z3) on a
server at the TU München.

The problem passed to the automatic provers consists of your current goal
together with a heuristic selection of hundreds of facts (theorems) from the
current theory context, filtered by relevance.

The result of a successful proof search is some source text that usually (but
not always) reconstructs the proof within Isabelle. For ATPs, the recon-
structed proof relies on the general-purpose metis proof method, which inte-
grates the Metis ATP in Isabelle/HOL with explicit inferences going through
the kernel. Thus its results are correct by construction.

For Isabelle/jEdit users, Sledgehammer provides an automatic mode that
can be enabled via the “Auto Sledgehammer” option under “Plugins > Plugin
Options > Isabelle > General.” In this mode, Sledgehammer is run on every
newly entered theorem.

To run Sledgehammer, you must make sure that the theory Sledgehammer
is imported—this is rarely a problem in practice since it is part of Main.
Examples of Sledgehammer use can be found in Isabelle’s src/HOL/Metis
Examples directory. Comments and bug reports concerning Sledgehammer
or this manual should be directed to the author at blanNOSPAMchette@in.tum.de.

2 Installation

Sledgehammer is part of Isabelle, so you do not need to install it. However,
it relies on third-party automatic provers (ATPs and SMT solvers).

Among the ATPs, agsyHOL, Alt-Ergo, E, LEO-II, Satallax, SPASS, and
Vampire can be run locally; in addition, agsyHOL, E, E-SInE, E-ToFoF,
iProver, iProver-Eq, LEO-II, Satallax, SNARK, Vampire, and Waldmeister
are available remotely via SystemOnTPTP [17]. If you want better perfor-
mance, you should at least install E and SPASS locally.

The SMT solvers CVC3, Yices, and Z3 can be run locally, and CVC3 and Z3
can be run remotely on a TUMünchen server. If you want better performance
and get the ability to replay proofs that rely on the smt proof method without
an Internet connection, you should at least have Z3 locally installed.

There are three main ways to install automatic provers on your machine:
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• If you installed an official Isabelle package, it should already include
properly setup executables for CVC3, E, SPASS, and Z3, ready to use.2
For Z3, you must additionally set the variable Z3 NON COMMERCIAL to
“yes” to confirm that you are a noncommercial user, either in the en-
vironment in which Isabelle is launched or in your $ISABELLE HOME
USER/etc/settings file.

• Alternatively, you can download the Isabelle-aware CVC3, E,
SPASS, and Z3 binary packages from http://isabelle.in.tum.de/
components/. Extract the archives, then add a line to your $ISABELLE
HOME USER/etc/components3 file with the absolute path to CVC3, E,
SPASS, or Z3. For example, if the components file does not exist yet
and you extracted SPASS to /usr/local/spass-3.8ds, create it with
the single line

/usr/local/spass-3.8ds

in it.

• If you prefer to build agsyHOL, Alt-Ergo, E, LEO-II, Satallax, or
SPASS manually, or found a Vampire executable somewhere (e.g.,
http://www.vprover.org/), set the environment variable AGSYHOL
HOME, E HOME, LEO2 HOME, SATALLAX HOME, SPASS HOME, or VAMPIRE
HOME to the directory that contains the agsyHOL, eprover (and/or
eproof or eproof ram), leo, satallax, SPASS, or vampire executable;
for Alt-Ergo, set the environment variable WHY3 HOME to the directory
that contains the why3 executable. Sledgehammer has been tested with
agsyHOL 1.0, Alt-Ergo 0.95.1, E 1.0 to 1.8, LEO-II 1.3.4, Satallax 2.2 to
2.7, SPASS 3.8ds, and Vampire 0.6 to 3.0.4Since the ATPs’ output for-
mats are neither documented nor stable, other versions might not work
well with Sledgehammer. Ideally, you should also set E VERSION, LEO2
VERSION, SATALLAX VERSION, SPASS VERSION, or VAMPIRE VERSION to
the prover’s version number (e.g., “1.8”).

Similarly, if you want to build CVC3, or found a Yices or Z3 executable
somewhere (e.g., http://yices.csl.sri.com/download.shtml or
http://research.microsoft.com/en-us/um/redmond/projects/

2Vampire’s and Yices’s licenses prevent us from doing the same for these otherwise
remarkable tools.

3The variable $ISABELLE HOME USER is set by Isabelle at startup. Its value can be
retrieved by executing isabelle getenv ISABELLE HOME USER on the command line.

4Following the rewrite of Vampire, the counter for version numbers was reset to 0;
hence the (new) Vampire versions 0.6, 1.0, 1.8, 2.6, and 3.0 are more recent than 9.0 or
11.5.
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z3/download.html), set the environment variable CVC3 SOLVER,
YICES SOLVER, or Z3 SOLVER to the complete path of the executable,
including the file name. Sledgehammer has been tested with CVC3
2.2 and 2.4.1, Yices 1.0.28 and 1.0.33, and Z3 3.0 to 4.0. Since the
SMT solvers’ output formats are somewhat unstable, other versions of
the solvers might not work well with Sledgehammer. Ideally, also set
CVC3 VERSION, YICES VERSION, or Z3 VERSION to the solver’s version
number (e.g., “4.0”).

To check whether E, SPASS, Vampire, and/or Z3 are successfully installed,
try out the example in §3. If the remote versions of any of these provers is
used (identified by the prefix “remote ”), or if the local versions fail to solve
the easy goal presented there, something must be wrong with the installation.

Remote prover invocation requires Perl with the World Wide Web Library
(libwww-perl) installed. If you must use a proxy server to access the In-
ternet, set the http proxy environment variable to the proxy, either in
the environment in which Isabelle is launched or in your $ISABELLE HOME
USER/etc/settings file. Here are a few examples:

http proxy=http://proxy.example.org
http proxy=http://proxy.example.org:8080
http proxy=http://joeblow:pAsSwRd@proxy.example.org

3 First Steps

To illustrate Sledgehammer in context, let us start a theory file and attempt
to prove a simple lemma:

theory Scratch
imports Main
begin

lemma “ [a] = [b] =⇒ a = b”
sledgehammer

Instead of issuing the sledgehammer command, you can also use the Sledge-
hammer panel in Isabelle/jEdit. Sledgehammer produces the following out-
put after a few seconds:

Sledgehammer: “e” on goal
[a] = [b] =⇒ a = b
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Try this: by (metis last ConsL) (64 ms).

Sledgehammer: “z3 ” on goal
[a] = [b] =⇒ a = b
Try this: by (metis list.inject) (20 ms).

Sledgehammer: “vampire” on goal
[a] = [b] =⇒ a = b
Try this: by (metis hd.simps) (14 ms).

Sledgehammer: “spass” on goal
[a] = [b] =⇒ a = b
Try this: by (metis list.inject) (17 ms).

Sledgehammer: “remote e sine” on goal
[a] = [b] =⇒ a = b
Try this: by (metis hd.simps) (18 ms).

Sledgehammer ran E, E-SInE, SPASS, Vampire, and Z3 in parallel. Depend-
ing on which provers are installed and how many processor cores are available,
some of the provers might be missing or present with a remote prefix. Wald-
meister is run only for unit equational problems, where the goal’s conclusion
is a (universally quantified) equation.

For each successful prover, Sledgehammer gives a one-liner metis or smt
method call. Rough timings are shown in parentheses, indicating how fast
the call is. You can click the proof to insert it into the theory text.

In addition, you can ask Sledgehammer for an Isar text proof by enabling
the isar proofs option (§7.4):

sledgehammer [isar proofs ]

When Isar proof construction is successful, it can yield proofs that are more
readable and also faster than the metis or smt one-liners. This feature is
experimental and is only available for ATPs.

4 Hints

This section presents a few hints that should help you get the most out of
Sledgehammer. Frequently asked questions are answered in §5.
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4.1 Presimplify the goal

For best results, first simplify your problem by calling auto or at least safe
followed by simp all. The SMT solvers provide arithmetic decision proce-
dures, but the ATPs typically do not (or if they do, Sledgehammer does not
use it yet). Apart from Waldmeister, they are not particularly good at heavy
rewriting, but because they regard equations as undirected, they often prove
theorems that require the reverse orientation of a simp rule. Higher-order
problems can be tackled, but the success rate is better for first-order prob-
lems. Hence, you may get better results if you first simplify the problem to
remove higher-order features.

4.2 Make sure E, SPASS, Vampire, and Z3 are locally
installed

Locally installed provers are faster and more reliable than those running on
servers. See §2 for details on how to install them.

4.3 Familiarize yourself with the main options

Sledgehammer’s options are fully documented in §6. Many of the options
are very specialized, but serious users of the tool should at least familiarize
themselves with the following options:

• provers (§7.1) specifies the automatic provers (ATPs and SMT solvers)
that should be run whenever Sledgehammer is invoked (e.g., “provers =
e spass remote vampire”). For convenience, you can omit “provers =”
and simply write the prover names as a space-separated list (e.g., “e
spass remote vampire”).

• max facts (§7.2) specifies the maximum number of facts that should
be passed to the provers. By default, the value is prover-dependent but
varies between about 50 and 1000. If the provers time out, you can try
lowering this value to, say, 25 or 50 and see if that helps.

• isar proofs (§7.4) specifies that Isar proofs should be generated, in
addition to one-liner metis or smt proofs. The length of the Isar proofs
can be controlled by setting isar compress (§7.4).
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• timeout (§7.6) controls the provers’ time limit. It is set to 30 seconds,
but since Sledgehammer runs asynchronously you should not hesitate
to raise this limit to 60 or 120 seconds if you are the kind of user who
can think clearly while ATPs are active.

Options can be set globally using sledgehammer params (§6). The com-
mand also prints the list of all available options with their current value. Fact
selection can be influenced by specifying “(add: my facts)” after the sledge-
hammer call to ensure that certain facts are included, or simply “(my facts)”
to force Sledgehammer to run only with my facts.

5 Frequently Asked Questions

This sections answers frequently (and infrequently) asked questions about
Sledgehammer. It is a good idea to skim over it now even if you do not have
any questions at this stage. And if you have any further questions not listed
here, send them to the author at blanNOSPAMchette@in.tum.de.

5.1 Which facts are passed to the automatic provers?

Sledgehammer heuristically selects a few hundred relevant lemmas from the
currently loaded libraries. The component that performs this selection is
called relevance filter.

• The traditional relevance filter, called MePo (Meng–Paulson), assigns
a score to every available fact (lemma, theorem, definition, or axiom)
based upon how many constants that fact shares with the conjecture.
This process iterates to include facts relevant to those just accepted.
The constants are weighted to give unusual ones greater significance.
MePo copes best when the conjecture contains some unusual constants;
if all the constants are common, it is unable to discriminate among the
hundreds of facts that are picked up. The filter is also memoryless: It
has no information about how many times a particular fact has been
used in a proof, and it cannot learn.

• An experimental alternative to MePo is MaSh (Machine Learner for
Sledgehammer). It relies on an external Python tool that applies ma-
chine learning to the problem of finding relevant facts.

• The MeSh filter combines MePo and MaSh.
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The default is either MePo or MeSh, depending on whether the environment
variable MASH is set and what class of provers the target prover belongs to
(§7.2).

The number of facts included in a problem varies from prover to prover, since
some provers get overwhelmed more easily than others. You can show the
number of facts given using the verbose option (§7.4) and the actual facts
using debug (§7.4).

Sledgehammer is good at finding short proofs combining a handful of existing
lemmas. If you are looking for longer proofs, you must typically restrict the
number of facts, by setting the max facts option (§7.2) to, say, 25 or 50.

You can also influence which facts are actually selected in a number of ways.
If you simply want to ensure that a fact is included, you can specify it using
the “(add: my facts)” syntax. For example:

sledgehammer (add : hd.simps tl.simps)

The specified facts then replace the least relevant facts that would otherwise
be included; the other selected facts remain the same. If you want to direct
the selection in a particular direction, you can specify the facts via using:

using hd.simps tl.simps
sledgehammer

The facts are then more likely to be selected than otherwise, and if they are
selected at iteration j they also influence which facts are selected at iterations
j + 1, j + 2, etc. To give them even more weight, try

using hd.simps tl.simps
apply –
sledgehammer

5.2 Why does Metis fail to reconstruct the proof?

There are many reasons. If Metis runs seemingly forever, that is a sign
that the proof is too difficult for it. Metis’s search is complete, so it should
eventually find it, but that’s little consolation. There are several possible
solutions:

• Try the isar proofs option (§7.4) to obtain a step-by-step Isar proof
where each step is justified by metis. Since the steps are fairly small,
metis is more likely to be able to replay them.
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• Try the smt proof method instead of metis. It is usually stronger, but
you need to either have Z3 available to replay the proofs, trust the SMT
solver, or use certificates. See the documentation in the SMT theory
($ISABELLE HOME/src/HOL/SMT.thy) for details.

• Try the blast or auto proof methods, passing the necessary facts via
unfolding, using, intro:, elim:, dest :, or simp:, as appropriate.

In some rare cases, metis fails fairly quickly, and you get the error message

One-line proof reconstruction failed.

This message indicates that Sledgehammer determined that the goal is prov-
able, but the proof is, for technical reasons, beyond metis ’s power. You can
then try again with the strict option (§7.3).

If the goal is actually unprovable and you did not specify an unsound encod-
ing using type enc (§7.3), this is a bug, and you are strongly encouraged to
report this to the author at blanNOSPAMchette@in.tum.de.

5.3 How can I tell whether a suggested proof is sound?

Earlier versions of Sledgehammer often suggested unsound proofs—either
proofs of nontheorems or simply proofs that rely on type-unsound inferences.
This is a thing of the past, unless you explicitly specify an unsound encod-
ing using type enc (§7.3). Officially, the only form of “unsoundness” that
lurks in the sound encodings is related to missing characteristic theorems of
datatypes. For example,

lemma “∃xs . xs 6= []”
sledgehammer ()

suggests an argumentless metis call that fails. However, the conjecture does
actually hold, and the metis call can be repaired by adding list.distinct. We
hope to address this problem in a future version of Isabelle. In the meantime,
you can avoid it by passing the strict option (§7.3).

5.4 What are the full types, no types, and mono tags
arguments to Metis?

The metis (full types) proof method and its cousin metis (mono tags) are
fully-typed versions of Metis. It is somewhat slower than metis, but the
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proof search is fully typed, and it also includes more powerful rules such as
the axiom “x = True ∨ x = False” for reasoning in higher-order places (e.g.,
in set comprehensions). The method kicks in automatically as a fallback
when metis fails, and it is sometimes generated by Sledgehammer instead
of metis if the proof obviously requires type information or if metis failed
when Sledgehammer preplayed the proof. (By default, Sledgehammer tries
to run metis with various options for up to 3 seconds each time to ensure
that the generated one-line proofs actually work and to display timing infor-
mation. This can be configured using the preplay timeout and dont preplay
options (§7.6).) At the other end of the soundness spectrum, metis (no
types) uses no type information at all during the proof search, which is more
efficient but often fails. Calls to metis (no types) are occasionally generated
by Sledgehammer. See the type enc option (§7.3) for details.

Incidentally, if you ever see warnings such as

Metis: Falling back on “metis (full types)”.

for a successfulmetis proof, you can advantageously pass the full types option
to metis directly.

5.5 And what are the lifting and hide lams arguments
to Metis?

Orthogonally to the encoding of types, it is important to choose an appropri-
ate translation of λ-abstractions. Metis supports three translation schemes,
in decreasing order of power: Curry combinators (the default), λ-lifting, and
a “hiding” scheme that disables all reasoning under λ-abstractions. The more
powerful schemes also give the automatic provers more rope to hang them-
selves. See the lam trans option (§7.3) for details.

5.6 Are generated proofs minimal?

Automatic provers frequently use many more facts than are necessary. Sledge-
hammer inclues a minimization tool that takes a set of facts returned by a
given prover and repeatedly calls the same prover, metis, or smt with subsets
of those axioms in order to find a minimal set. Reducing the number of ax-
ioms typically improves Metis’s speed and success rate, while also removing
superfluous clutter from the proof scripts.
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In earlier versions of Sledgehammer, generated proofs were systematically
accompanied by a suggestion to invoke the minimization tool. This step is
now performed implicitly if it can be done in a reasonable amount of time
(something that can be guessed from the number of facts in the original proof
and the time it took to find or preplay it).

In addition, some provers (e.g., Yices) do not provide proofs or sometimes
produce incomplete proofs. The minimizer is then invoked to find out which
facts are actually needed from the (large) set of facts that was initially given
to the prover. Finally, if a prover returns a proof with lots of facts, the min-
imizer is invoked automatically since Metis would be unlikely to re-find the
proof. Automatic minimization can be forced or disabled using the minimize
option (§7.1).

5.7 A strange error occurred—what should I do?

Sledgehammer tries to give informative error messages. Please report any
strange error to the author at blanNOSPAMchette@in.tum.de. This applies doubly
if you get the message

The prover derived “False” using “foo”, “bar ”, and “baz ”. This could be
due to inconsistent axioms (including “sorry”s) or to a bug in Sledge-
hammer. If the problem persists, please contact the Isabelle developers.

5.8 Auto can solve it—why not Sledgehammer?

Problems can be easy for auto and difficult for automatic provers, but the
reverse is also true, so do not be discouraged if your first attempts fail.
Because the system refers to all theorems known to Isabelle, it is particularly
suitable when your goal has a short proof from lemmas that you do not know
about.

5.9 Why are there so many options?

Sledgehammer’s philosophy should work out of the box, without user guid-
ance. Many of the options are meant to be used mostly by the Sledgehammer
developers for experiments. Of course, feel free to try them out if you are so
inclined.
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6 Command Syntax

6.1 Sledgehammer

Sledgehammer can be invoked at any point when there is an open goal by
entering the sledgehammer command in the theory file. Its general syntax
is as follows:

sledgehammer 〈subcommand〉? 〈options〉? 〈facts override〉? 〈num〉?

In the general syntax, the 〈subcommand〉 may be any of the following:

• run (the default): Runs Sledgehammer on subgoal number 〈num〉
(1 by default), with the given options and facts.

• min: Attempts to minimize the facts specified in the 〈facts override〉
argument to obtain a simpler proof involving fewer facts. The options
and goal number are as for run.

• messages: Redisplays recent messages issued by Sledgehammer. This
allows you to examine results that might have been lost due to Sledge-
hammer’s asynchronous nature. The 〈num〉 argument specifies a limit
on the number of messages to display (10 by default).

• supported provers: Prints the list of automatic provers supported by
Sledgehammer. See §2 and §7.1 for more information on how to install
automatic provers.

• running provers: Prints information about currently running au-
tomatic provers, including elapsed runtime and remaining time until
timeout.

• kill all : Terminates all running threads (automatic provers and ma-
chine learners).

• refresh tptp: Refreshes the list of remote ATPs available at System-
OnTPTP [17].

In addition, the following subcommands provide finer control over machine
learning with MaSh:

• unlearn: Resets MaSh, erasing any persistent state.

• learn isar : Invokes MaSh on the current theory to process all the
available facts, learning from their Isabelle/Isar proofs. This happens
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automatically at Sledgehammer invocations if the learn option (§7.2)
is enabled.

• learn prover : Invokes MaSh on the current theory to process all the
available facts, learning from proofs generated by automatic provers.
The prover to use and its timeout can be set using the prover (§7.1)
and timeout (§7.6) options. It is recommended to perform learning
using an efficient first-order ATP (such as E, SPASS, and Vampire) as
opposed to a higher-order ATP or an SMT solver.

• relearn isar : Same as unlearn followed by learn isar.

• relearn prover : Same as unlearn followed by learn prover.

• running learners: Prints information about currently running ma-
chine learners, including elapsed runtime and remaining time until
timeout.

Sledgehammer’s behavior can be influenced by various 〈options〉, which can
be specified in brackets after the sledgehammer command. The 〈options〉
are a list of key–value pairs of the form “[k1 = v1, . . . , kn = vn ]”. For Boolean
options, “= true” is optional. For example:

sledgehammer [isar proofs, timeout = 120]

Default values can be set using sledgehammer params:

sledgehammer params 〈options〉

The supported options are described in §7.

The 〈facts override〉 argument lets you alter the set of facts that go through
the relevance filter. It may be of the form “(〈facts〉)”, where 〈facts〉 is a space-
separated list of Isabelle facts (theorems, local assumptions, etc.), in which
case the relevance filter is bypassed and the given facts are used. It may
also be of the form “(add : 〈facts1〉)”, “(del : 〈facts2〉)”, or “(add : 〈facts1〉 del :
〈facts2〉)”, where the relevance filter is instructed to proceed as usual except
that it should consider 〈facts1〉 highly-relevant and 〈facts2〉 fully irrelevant.

If you use Isabelle/jEdit, Sledgehammer also provides an automatic mode
that can be enabled via the “Auto Sledgehammer” option under “Plugins >
Plugin Options > Isabelle > General.” For automatic runs, only the first
prover set using provers (§7.1) is considered, fewer facts are passed to the
prover, slice (§7.1) is disabled, strict (§7.3) is enabled, verbose (§7.4) and
debug (§7.4) are disabled, and timeout (§7.6) is superseded by the “Auto
Time Limit” option in jEdit. Sledgehammer’s output is also more concise.
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6.2 Metis

The metis proof method has the syntax

metis (〈options〉)? 〈facts〉?

where 〈facts〉 is a list of arbitrary facts and 〈options〉 is a comma-separated
list consisting of at most one λ translation scheme specification with the same
semantics as Sledgehammer’s lam trans option (§7.3) and at most one type
encoding specification with the same semantics as Sledgehammer’s type enc
option (§7.3). The supported λ translation schemes are hide lams, lifting,
and combs (the default). All the untyped type encodings listed in §7.3 are
supported. For convenience, the following aliases are provided:

• full types: Alias for poly guards query.

• partial types: Alias for poly args.

• no types: Alias for erased.

7 Option Reference

Sledgehammer’s options are categorized as follows: mode of operation (§7.1),
problem encoding (§7.3), relevance filter (§7.2), output format (§7.4), au-
thentication (§7.5), and timeouts (§7.6).

The descriptions below refer to the following syntactic quantities:

• 〈string〉: A string.

• 〈bool〉: true or false.

• 〈smart bool〉: true, false, or smart.

• 〈int〉: An integer.

• 〈float pair〉: A pair of floating-point numbers (e.g., 0.6 0.95).

• 〈smart int〉: An integer or smart.

• 〈float or none〉: A floating-point number (e.g., 60 or 0.5) expressing
a number of seconds, or the keyword none (∞ seconds).

Default values are indicated in curly brackets ({}). Boolean options have a
negative counterpart (e.g., blocking vs. non blocking). When setting Boolean
options or their negative counterparts, “= true” may be omitted.
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7.1 Mode of Operation[
provers =

]
〈string〉

Specifies the automatic provers to use as a space-separated list (e.g.,
“e spass remote vampire”). Provers can be run locally or remotely; see
§2 for installation instructions.

The following local provers are supported:

• agsyHOL: agsyHOL is an automatic higher-order prover devel-
oped by Fredrik Lindblad [12], with support for the TPTP typed
higher-order syntax (THF0). To use agsyHOL, set the environ-
ment variable AGSYHOL HOME to the directory that contains the
agsyHOL executable. Sledgehammer has been tested with version
1.0.

• alt ergo: Alt-Ergo is a polymorphic ATP developed by Bobot
et al. [3]. It supports the TPTP polymorphic typed first-order
format (TFF1) via Why3 [4]. To use Alt-Ergo, set the environ-
ment variable WHY3 HOME to the directory that contains the why3
executable. Sledgehammer has been tested with Alt-Ergo 0.95.1
and an unidentified development version of Why3.

• cvc3 : CVC3 is an SMT solver developed by Clark Barrett, Cesare
Tinelli, and their colleagues [1]. To use CVC3, set the environment
variable CVC3 SOLVER to the complete path of the executable, in-
cluding the file name, or install the prebuilt CVC3 package from
http://isabelle.in.tum.de/components/. Sledgehammer has
been tested with version 2.2 and 2.4.1.

• e: E is a first-order resolution prover developed by Stephan Schulz
[14]. To use E, set the environment variable E HOME to the direc-
tory that contains the eproof executable and E VERSION to the
version number (e.g., “1.8”), or install the prebuilt E package from
http://isabelle.in.tum.de/components/. Sledgehammer has
been tested with versions 1.0 to 1.8.

• e males: E-MaLeS is a metaprover developed by Daniel
Kühlwein that implements strategy scheduling on top of E. To
use E-MaLeS, set the environment variable E MALES HOME to the
directory that contains the emales.py script. Sledgehammer has
been tested with version 1.1.

• e par : E-Par is a metaprover developed by Josef Urban that im-
plements strategy scheduling on top of E. To use E-Par, set the
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environment variable E HOME to the directory that contains the
runepar.pl script and the eprover and epclextract executa-
bles, or use the prebuilt E package from http://isabelle.in.
tum.de/components/.

• iprover : iProver is a pure instantiation-based prover developed
by Konstantin Korovin [10]. To use iProver, set the environment
variable IPROVER HOME to the directory that contains the iprover
and vclausify rel executables. Sledgehammer has been tested
with version 0.99.

• iprover eq : iProver-Eq is an instantiation-based prover with na-
tive support for equality developed by Konstantin Korovin and
Christoph Sticksel [11]. To use iProver-Eq, set the environ-
ment variable IPROVER EQ HOME to the directory that contains
the iprover-eq and vclausify rel executables. Sledgehammer
has been tested with version 0.8.

• leo2 : LEO-II is an automatic higher-order prover developed by
Christoph Benzmüller et al. [2], with support for the TPTP typed
higher-order syntax (THF0). To use LEO-II, set the environment
variable LEO2 HOME to the directory that contains the leo exe-
cutable. Sledgehammer requires version 1.3.4 or above.

• metis: Although it is less powerful than the external provers,
Metis itself can be used for proof search.

• satallax : Satallax is an automatic higher-order prover developed
by Chad Brown et al. [6], with support for the TPTP typed higher-
order syntax (THF0). To use Satallax, set the environment vari-
able SATALLAX HOME to the directory that contains the satallax
executable. Sledgehammer requires version 2.2 or above.

• smt : The smt proof method with the current settings (usually:
Z3 with proof reconstruction) can be used for proof search.

• spass: SPASS is a first-order resolution prover developed by
Christoph Weidenbach et al. [18]. To use SPASS, set the en-
vironment variable SPASS HOME to the directory that contains
the SPASS executable and SPASS VERSION to the version num-
ber (e.g., “3.8ds”), or install the prebuilt SPASS package from
http://isabelle.in.tum.de/components/. Sledgehammer re-
quires version 3.8ds or above.

• vampire: Vampire is a first-order resolution prover developed
by Andrei Voronkov and his colleagues [13]. To use Vampire, set
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the environment variable VAMPIRE HOME to the directory that con-
tains the vampire executable and VAMPIRE VERSION to the version
number (e.g., “2.6”). Sledgehammer has been tested with versions
0.6 to 3.0. Versions strictly above 1.8 support the TPTP typed
first-order format (TFF0).

• yices: Yices is an SMT solver developed at SRI [7]. To use Yices,
set the environment variable YICES SOLVER to the complete path
of the executable, including the file name. Sledgehammer has been
tested with version 1.0.28.

• z3 : Z3 is an SMT solver developed at Microsoft Research [19]. To
use Z3, set the environment variable Z3 SOLVER to the complete
path of the executable, including the file name, and set Z3 NON
COMMERCIAL to “yes” to confirm that you are a noncommercial
user. Sledgehammer has been tested with versions 3.0, 3.1, 3.2,
and 4.0.

The following remote provers are supported:

• remote agsyhol : The remote version of agsyHOL runs on Geoff
Sutcliffe’s Miami servers [17].

• remote cvc3 : The remote version of CVC3 runs on servers at
the TU München (or wherever REMOTE SMT URL is set to point).

• remote e: The remote version of E runs on Geoff Sutcliffe’s Mi-
ami servers [17].

• remote e sine: E-SInE is a metaprover developed by Kryštof
Hoder [9] based on E. It runs on Geoff Sutcliffe’s Miami servers.

• remote e tofof : E-ToFoF is a metaprover developed by Geoff
Sutcliffe [16] based on E running on his Miami servers. This ATP
supports the TPTP typed first-order format (TFF0). The remote
version of E-ToFoF runs on Geoff Sutcliffe’s Miami servers.

• remote iprover : The remote version of iProver runs on Geoff
Sutcliffe’s Miami servers [17].

• remote iprover eq : The remote version of iProver-Eq runs on
Geoff Sutcliffe’s Miami servers [17].

• remote leo2 : The remote version of LEO-II runs on Geoff Sut-
cliffe’s Miami servers [17].

• remote satallax : The remote version of Satallax runs on Geoff
Sutcliffe’s Miami servers [17].
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• remote snark : SNARK is a first-order resolution prover devel-
oped by Stickel et al. [15]. It supports the TPTP typed first-order
format (TFF0). The remote version of SNARK runs on Geoff
Sutcliffe’s Miami servers.

• remote vampire: The remote version of Vampire runs on Geoff
Sutcliffe’s Miami servers.

• remote waldmeister : Waldmeister is a unit equality prover de-
veloped by Hillenbrand et al. [8]. It can be used to prove uni-
versally quantified equations using unconditional equations, cor-
responding to the TPTP CNF UEQ division. The remote version
of Waldmeister runs on Geoff Sutcliffe’s Miami servers.

• remote z3 : The remote version of Z3 runs on servers at the TU
München (or wherever REMOTE SMT URL is set to point).

By default, Sledgehammer runs a selection of CVC3, E, E-SInE, SPASS,
Vampire, Yices, and Z3 in parallel—either locally or remotely, depend-
ing on the number of processor cores available.

It is generally a good idea to run several provers in parallel. Running
E, SPASS, and Vampire for 5 seconds yields a similar success rate to
running the most effective of these for 120 seconds [5].

For themin subcommand, the default prover ismetis. If several provers
are set, the first one is used.

prover = 〈string〉
Alias for provers.

blocking
[
= 〈bool〉

]
{false} (neg.: non blocking)

Specifies whether the sledgehammer command should operate syn-
chronously. The asynchronous (non-blocking) mode lets the user start
proving the putative theorem manually while Sledgehammer looks for
a proof, but it can also be more confusing. Irrespective of the value of
this option, Sledgehammer is always run synchronously if debug (§7.4)
is enabled.

slice
[
= 〈bool〉

]
{true} (neg.: dont slice)

Specifies whether the time allocated to a prover should be sliced into
several segments, each of which has its own set of possibly prover-
dependent options. For SPASS and Vampire, the first slice tries the
fast but incomplete set-of-support (SOS) strategy, whereas the second
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slice runs without it. For E, up to three slices are tried, with differ-
ent weighted search strategies and number of facts. For SMT solvers,
several slices are tried with the same options each time but fewer and
fewer facts. According to benchmarks with a timeout of 30 seconds,
slicing is a valuable optimization, and you should probably leave it en-
abled unless you are conducting experiments. This option is implicitly
disabled for (short) automatic runs.

See also verbose (§7.4).

minimize
[
= 〈smart bool〉

]
{smart} (neg.: dont minimize)

Specifies whether the minimization tool should be invoked automati-
cally after proof search. By default, automatic minimization takes place
only if it can be done in a reasonable amount of time (as determined
by the number of facts in the original proof and the time it took to
find or preplay it) or the proof involves an unreasonably large number
of facts.

See also preplay timeout (§7.6) and dont preplay (§7.6).

spy
[
= 〈bool〉

]
{false} (neg.: dont spy)

Specifies whether Sledgehammer should record statistics in $ISABELLE
HOME USER/spy sledgehammer. These statistics can be useful to the
developers of Sledgehammer. If you are willing to have your interactions
recorded in the name of science, please enable this feature and send
the statistics file every now and then to the author of this manual
(blanNOSPAMchette@in.tum.de). To change the default value of this option
globally, set the environment variable SLEDGEHAMMER SPY to yes.

See also debug (§7.4).

overlord
[
= 〈bool〉

]
{false} (neg.: no overlord)

Specifies whether Sledgehammer should put its temporary files in $ISA-
BELLE HOME USER, which is useful for debugging Sledgehammer but
also unsafe if several instances of the tool are run simultaneously. The
files are identified by the prefixes prob and mash ; you may safely
remove them after Sledgehammer has run.

See also debug (§7.4).
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7.2 Relevance Filter

fact filter = 〈string〉 {smart}

Specifies the relevance filter to use. The following filters are available:

• mepo: The traditional memoryless MePo relevance filter.

• mash: The experimental MaSh machine learner. MaSh relies on
the external Python program mash.py, which is part of Isabelle.
To enable MaSh, set the environment variable MASH to yes. Persis-
tent data is stored in the directory $ISABELLE HOME USER/mash.

• mesh: The MeSh filter, which combines the rankings from MePo
and MaSh.

• smart : A mixture of MePo, MaSh, and MeSh if MaSh is enabled;
otherwise, MePo.

max facts = 〈smart int〉 {smart}

Specifies the maximum number of facts that may be returned by the
relevance filter. If the option is set to smart, it is set to a value that
was empirically found to be appropriate for the prover. Typical values
range between 50 and 1000.

For the MaSh-related commands learn isar, learn prover, relearn isar,
and relearn prover, this option specifies the maximum number of facts
from the background library that should be learned (∞ by default).

fact thresholds = 〈float pair〉 {0.45 0.85}

Specifies the thresholds above which facts are considered relevant by
the relevance filter. The first threshold is used for the first iteration of
the relevance filter and the second threshold is used for the last iteration
(if it is reached). The effective threshold is quadratically interpolated
for the other iterations. Each threshold ranges from 0 to 1, where 0
means that all theorems are relevant and 1 only theorems that refer to
previously seen constants.

learn
[
= 〈bool〉

]
{true} (neg.: dont learn)

Specifies whether MaSh should be run automatically by Sledgeham-
mer to learn the available theories (and hence provide more accurate
results). Learning takes place only if MaSh is enabled.

max new mono instances = 〈int〉 {smart}

Specifies the maximum number of monomorphic instances to generate
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beyond max facts. The higher this limit is, the more monomorphic
instances are potentially generated. Whether monomorphization takes
place depends on the type encoding used. If the option is set to smart,
it is set to a value that was empirically found to be appropriate for the
prover. For most provers, this value is 100.

See also type enc (§7.3).

max mono iters = 〈int〉 {smart}

Specifies the maximum number of iterations for the monomorphization
fixpoint construction. The higher this limit is, the more monomorphic
instances are potentially generated. Whether monomorphization takes
place depends on the type encoding used. If the option is set to smart,
it is set to a value that was empirically found to be appropriate for the
prover. For most provers, this value is 3.

See also type enc (§7.3).

7.3 Problem Encoding

lam trans = 〈string〉 {smart}

Specifies the λ translation scheme to use in ATP problems. The sup-
ported translation schemes are listed below:

• hide lams: Hide the λ-abstractions by replacing them by un-
specified fresh constants, effectively disabling all reasoning under
λ-abstractions.

• lifting : Introduce a new supercombinator c for each cluster of
n λ-abstractions, defined using an equation c x1 . . . xn = t (λ-
lifting).

• combs: Rewrite lambdas to the Curry combinators (I, K, S, B, C).
Combinators enable the ATPs to synthesize λ-terms but tend to
yield bulkier formulas than λ-lifting: The translation is quadratic
in the worst case, and the equational definitions of the combinators
are very prolific in the context of resolution.

• combs and lifting : Introduce a new supercombinator c for each
cluster of λ-abstractions and characterize it both using a lifted
equation c x1 . . . xn = t and via Curry combinators.

• combs or lifting : For each cluster of λ-abstractions, heuristi-
cally choose between λ-lifting and Curry combinators.
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• keep lams: Keep the λ-abstractions in the generated problems.
This is available only with provers that support the THF0 syntax.

• smart : The actual translation scheme used depends on the ATP
and should be the most efficient scheme for that ATP.

For SMT solvers, the λ translation scheme is always lifting, irrespective
of the value of this option.

uncurried aliases
[
= 〈smart bool〉

]
{smart}
(neg.: no uncurried aliases)

Specifies whether fresh function symbols should be generated as aliases
for applications of curried functions in ATP problems.

type enc = 〈string〉 {smart}

Specifies the type encoding to use in ATP problems. Some of the type
encodings are unsound, meaning that they can give rise to spurious
proofs (unreconstructible using metis). The type encodings are listed
below, with an indication of their soundness in parentheses. An asterisk
(*) indicates that the encoding is slightly incomplete for reconstruction
with metis, unless the strict option (described below) is enabled.

• erased (unsound): No type information is supplied to the ATP,
not even to resolve overloading. Types are simply erased.

• poly guards (sound): Types are encoded using a predicate
g(τ, t) that guards bound variables. Constants are annotated with
their types, supplied as extra arguments, to resolve overloading.

• poly tags (sound): Each term and subterm is tagged with its
type using a function t(τ, t).

• poly args (unsound): Like for poly guards constants are anno-
tated with their types to resolve overloading, but otherwise no
type information is encoded. This is the default encoding used by
the metis command.

• raw mono guards, raw mono tags (sound);
raw mono args (unsound):
Similar to poly guards, poly tags, and poly args, respectively, but
the problem is additionally monomorphized, meaning that type
variables are instantiated with heuristically chosen ground types.
Monomorphization can simplify reasoning but also leads to larger
fact bases, which can slow down the ATPs.
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• mono guards, mono tags (sound); mono args (unsound):
Similar to raw mono guards, raw mono tags, and raw mono args,
respectively but types are mangled in constant names instead of
being supplied as ground term arguments. The binary predicate
g(τ, t) becomes a unary predicate g τ(t), and the binary function
t(τ, t) becomes a unary function t τ(t).

• mono native (sound): Exploits native first-order types if the
prover supports the TFF0, TFF1, or THF0 syntax; otherwise,
falls back on mono guards. The problem is monomorphized.

• mono native higher (sound): Exploits native higher-order types
if the prover supports the THF0 syntax; otherwise, falls back on
mono native or mono guards. The problem is monomorphized.

• poly native (sound): Exploits native first-order polymorphic
types if the prover supports the TFF1 syntax; otherwise, falls
back on mono native.

• poly guards?, poly tags?, raw mono guards?,
raw mono tags?, mono guards?, mono tags?,
mono native? (sound*):
The type encodings poly guards, poly tags, raw mono guards, raw
mono tags, mono guards, mono tags, and mono native are fully
typed and sound. For each of these, Sledgehammer also provides
a lighter variant identified by a question mark (‘?’) that detects
and erases monotonic types, notably infinite types. (For mono
native, the types are not actually erased but rather replaced by
a shared uniform type of individuals.) As argument to the metis
proof method, the question mark is replaced by a “ query” suffix.

• poly guards??, poly tags??, raw mono guards??,
raw mono tags??, mono guards??, mono tags??
(sound*):
Even lighter versions of the ‘?’ encodings. As argument to the
metis proof method, the ‘??’ suffix is replaced by “ query query”.

• poly guards@, poly tags@, raw mono guards@,
raw mono tags@ (sound*):
Alternative versions of the ‘??’ encodings. As argument to the
metis proof method, the ‘@’ suffix is replaced by “ at”.

• poly args?, raw mono args? (unsound):
Lighter versions of poly args and raw mono args.
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• smart : The actual encoding used depends on the ATP and should
be the most efficient sound encoding for that ATP.

For SMT solvers, the type encoding is always mono native, irrespective
of the value of this option.

See also max new mono instances (§7.2) and max mono iters (§7.2).

strict
[
= 〈bool〉

]
{false} (neg.: non strict)

Specifies whether Sledgehammer should run in its strict mode. In that
mode, sound type encodings marked with an asterisk (*) above are
made complete for reconstruction withmetis, at the cost of some clutter
in the generated problems. This option has no effect if type enc is
deliberately set to an unsound encoding.

7.4 Output Format

verbose
[
= 〈bool〉

]
{false} (neg.: quiet)

Specifies whether the sledgehammer command should explain what
it does. This option is implicitly disabled for automatic runs.

debug
[
= 〈bool〉

]
{false} (neg.: no debug)

Specifies whether Sledgehammer should display additional debugging
information beyond what verbose already displays. Enabling debug
also enables verbose and blocking (§7.1) behind the scenes. The debug
option is implicitly disabled for automatic runs.

See also spy (§7.1) and overlord (§7.1).

isar proofs
[
= 〈smart bool〉

]
{smart} (neg.: no isar proofs)

Specifies whether Isar proofs should be output in addition to one-liner
metis proofs. The construction of Isar proof is still experimental and
may sometimes fail; however, when they succeed they are usually faster
and more intelligible than metis proofs. If the option is set to smart
(the default), Isar proofs are only generated when no working one-liner
metis proof is available.

isar compress = 〈int〉 {10}
Specifies the granularity of the generated Isar proofs if isar proofs is
explicitly enabled. A value of n indicates that each Isar proof step
should correspond to a group of up to n consecutive proof steps in the
ATP proof.
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dont compress isar
[
= true

]
Alias for “isar compress = 0”.

isar try0
[
= 〈bool〉

]
{true} (neg.: dont try0 isar)

Specifies whether standard proof methods such as auto and blast should
be tried as alternatives to metis and smt in Isar proofs. The collection
of methods is roughly the same as for the try0 command.

7.5 Authentication

expect = 〈string〉
Specifies the expected outcome, which must be one of the following:

• some: Sledgehammer found a proof.

• none: Sledgehammer found no proof.

• timeout : Sledgehammer timed out.

• unknown: Sledgehammer encountered some problem.

Sledgehammer emits an error (if blocking is enabled) or a warning (oth-
erwise) if the actual outcome differs from the expected outcome. This
option is useful for regression testing.

See also blocking (§7.1) and timeout (§7.6).

7.6 Timeouts

timeout = 〈float or none〉 {30}
Specifies the maximum number of seconds that the automatic provers
should spend searching for a proof. This excludes problem preparation
and is a soft limit. For automatic runs, the “Auto Time Limit” option
under “Plugins > Plugin Options > Isabelle > General” is used instead.

preplay timeout = 〈float or none〉 {3}
Specifies the maximum number of seconds that metis or smt should
spend trying to “preplay” the found proof. If this option is set to 0, no
preplaying takes place, and no timing information is displayed next to
the suggested metis calls.

See also minimize (§7.1).
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dont preplay
[
= true

]
Alias for “preplay timeout = 0”.
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